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Newsletter Work Disk called "Personal." If it's not there you 
can copy it from the Personal Newsletter master using the 
desktop file copy option. 

You can also look at the contents of a photo album at any 
time. If you are on the desktop, and the work disk is in the 
drive, click on the disk icon and the Photo Album icon should 
be on one of the pages. 

Click on the geos menu and select the "Photo Manager" desk 
accessory. Then click on the "Open" box and the names of 
all the albums on the current disk will be displayed. 
Highlight the one you want to access and click "Open." 
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I Create I new photo album 

I existing photo album 

~~I 

The first picture is displayed. The bottom of the screen 
indicates how many pictures are in the album. Display the 
next one by clicking on the left bottom corner where it's 
folded over. When you are finished looking at the pictures, 
click on the close box on the top right corner. 

You can only have one photo album on a work disk at once. 
Those photos will appear in a Photo Window on your page. 
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Load Personal Newsletter from the desktop by double 
clicking on its icon. Then load the page you plan to put 
graphics into such as "FORM." (Select "File" and "Load" 
from the menu. Highlight FORM and click on "Open. ") 

Now when you create a Photo Window, the pictures in the 
"Personal" photo album will be displayed. 

You create windows for photos that will appear in your 
newsletter in the same way that you create text windows 

Move the pointer to "Photo" in the menu bar and click. 
Select "Create" from the "Photo" menu by clicking on it. 
Then, like creating a text window, move the pointer to a 
place on screen where you want the top left comer of the 
photo window to appear and click once. 

Stretch the window, by moving the pointer. When it's the 
size you want, click to lock it into place. 
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(Don't move the pointer yet. A menu opens at the top with 
positioning arrows and the pointer will appear in the menu.) 

When you lock in the photo window, the fIrst picture in the 
photo album that you selected will be displayed. 

o 

2 

We've Had Eno 

Fox and Dog Just Plain Tired 
Of Tedious Typing Test II 

over the dog. The quick 
brown fox jumped over the 
dog again. And the quick 
brown fox jumped over the 
dog yet again. 

go 
life jumping over 

you. What's the point! 
This whole exercise who 
dreamed up by some crazy 
typing teacher. Instead of 

Another menu is displayed which gives you the ability the 
move the picture around or move to another picture. 
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Change 
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Click on the arrow keys to move the picture within the 
window. Click on the plus symbol to move forward to 
another picture, or the minus symbol to move back. The 
picture's number is shown at the right side of the menu. If 
you hold the button down on the Plus or Minus the 
program will scan quickly through the numbers so you can 
jump to a particular picture. 

When you have selected a photo and positioned it in the 
window, move the cursor off the menu and the picture is set. 

You can set up photo windows anywhere on the page. You 
can also cause text to wrap around a picture by placing the 
photo window in the text where you want it to wrap. 

If there is already text there, it will wrap around the picture 
automatically. Or, if you enter text later, it will wrap as well. 
If you edit or change the text, it will automatically readjust 
around the picture. 

If there isn't enough room for the picture, you can change the 
size of the window by selecting the "Photo" option and 
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Remove 
Photo 

Move Photo 

Saving 

"Change Size." Like text windows, move the pointer over 
the window to change and click. Move the pointer to make 
the window the size you want. Click to "freeze" the window. 

You can readjust the position of the photo by clicking on it. 
The adjust menu will appear at the top. 

A window can easily be deleted. Select "Photo" and the 

"Remove" option. Click on the window to delete. It will 
disappear. Click again to remove it permanently. 

A photo window can also be moved to a different place on the 
page. First select "Photo" and the "Move" option. Move the 
pointer to the window and click on it. Then move the pointer 
to the place you want the window to appear. When you click 
again, the window will be locked into the new position. 

When you've finished the layout, you can save it, even 
though you haven't put all the text in yet. 

Save as you go along in case something happens to interrupt 
the power to the computer. 
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Click on the File menu and select "Save." A dialogue box 
prompts for a file name. Enter a name up to 16 characters 
long and press RETURN. If you have been using an existing 
page file, its name is displayed and you can press RETURN. 

1 

2 

ENTER FILE NAME: 

Samplel 

I Cancel ~ 
text scril)J-o __ ..... .,._-----__ ... 

can be pasted 
elsewhere on the 
page. 

If you intend to use the same layout for your page each time, 
save a "generic" copy of the layout. This might include the 
banner or title at the top and anything else that is the same 
from issue to issue. Saved it as "News.Temp" for example. 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

Personal Newsletter Chapter 4: Creating A Layout 

Design a 
Newsletter 

Layout 
the Page 

Each time you use "News.Temp," load it from disk, using the 
File menu. Then, after you enter in the current newletter 
information, instead of resaving it as "News. Temp" save it 
with a different file name, like "June1.News." 

An important consideration is the "direction" of your 
newsletter. Is the newsletter being created to address 
business issues, educational or leisure activities. 

To get ideas, look at newsletters that appeal to you and that 
you think get their message across effectively. The main 
purpose is to communicate your message or idea while 
making the newsletter aesthetically pleasing. Model your 
design on newsletters that exhibit both these qualities. 

Once you have a design that appeals to you, use this section 
to try it out and experiment with modifications. 

Try the design out on different people. Often other people 
have some great ideas on improving a draft design. 
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A slick headline or graphic is a good attention getter. People 
like pictures. A nice looking picture will draw their attention 
and make them want to see what your newsletter is about. 

You have probably achieved a good design if the layout 
appeals to you and your "critics." There are a couple of hints 
you should keep in mind for newsletters. 

Try not to use a lot of columns. For example, the FORM 
newsletter uses three columns. Generally, using more than 
three columns makes the newsletter appear cluttered. 

The same is true for pictures and graphics. Pictures and 
graphics are effective for grabbing the attention of readers 
but too many pictures will make reading the newsletter 
(which is the main purpose) a chore. 
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Chapter 5: 
Creating Text 

Entering text into Personal Newsletter is a simple process, 
but there are a number of editing and style options available 
that can embellish your documents. 

Entering text is usually the second step in creating a 
newsletter, after you have designed a general layout. 

To illustrate the text editing and style features of Personal 
Newsletter it may help to load a file that contains a block of 
text. 
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Click on the File menu and select Load. A list of file names 
is displayed. Move the pointer over "Text" and select it. 

Then click on Open. A short story will appear on screen. 

PHOTO I WINDOW I STYLEI FONTI TEXT I PRINTI FILE I QUIT I 67% Free 

0 1 1 12 13 

0 

Ir~~ ~~ ;~, ~ We've Had Eno 
il~~ .. ;(i 

-- Fox and Dog Just Plain Tired 1 

Of Tedious Typing Test!! 
The quick brown fox jumped stupl<1. 1 Clon t want to go 
over the dog. The quick through life jumping over 
brown fox jumped over the you. What's the point! 
dog again. And the quick This whole exercise who 

- brown fox jumped over the dreamed up by some crazy 
2 dog yet again. typing teacher. Instead of 

You can enter text in any window by pressing the keys. 

Select a window by moving the pointer to the window and 

clicking. If you continue to move the pointer down the page it 

will display more of the existing text and a blank window. 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

Personal Newsletter Chapter 5: Creating Text 

Text Edit 

Insert 

Moving 
Around 

Personal Newsletter works like a word processor. Type in 
text at the cursor. When the cursor reaches the end of a line 
in the column it will go to the next line. If a word is too long 
to fit at the end of a line, it "wraps" around to the next line. 

If you make a mistake, you can backspace over a letter or 
word using the delete key (top, right corner of the keyboard). 

To edit text anywhere on a page simply move the pointer to 

the word and click. The cursor will flash at the edit point and 
you can add text or delete. 

The program uses a style called BSW font but it can be 
changed to other fonts, which is explained in this chapter. 

The program is always in insert mode. That means if you 
type text in the middle of a sentence, all text after it will be 
pushed forward so the new text can be inserted. 

Use your mouse or joystick to move the pointer around the 
screen. When you get to the place you want to be, click on 
the button to bring the cursor to where the pointer is. 
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Another feature of Personal Newsletter is the ability to cut, 
copy and paste text in blocks. The program creates a "scrap" 
where it stores text that can be pasted elsewhere on a page. 

To use the Text option, you need to define the range of text 
first. Move the pointer to the left of the first character in the 
block of text to define and click to bring the cursor there. 

Hold down the button and move the pointer to the last 
character in the range. The text you have selected inverses. 

Click on the Text menu. You'll see three options: Cut, Copy, 
and Paste. 

First try cutting some text and pasting it elsewhere. Move 
the pointer to the beginning of the text in the first column, 
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Paste 

"The quick.." Click on the left of the T and hold the button 
down. Move the pointer down to the end of line four, after 
"jumped." The block will be highlighted. 

1 

2 

We've Had Eno 

Fox and Dog Just Plain Tired 
Of Tedious Typing Test!! 

through life jumping over 
you. What's the point! 
This whole exercise who 
dreamed up by some crazy 
typing teacher. Instead of 

Select the Cut option from the Text menu by clicking on it. 
The text will disappear from the window but it is actually 
stored as a text scrap. 

The text scrap can be pasted elsewhere on the page. 
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Copy 

Style 
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Click on the Text menu option again and select Paste. It will 
darken, indicating that there is text available for pasting. (If 

you didn't cut some text, paste wouldn't be activated.) 

Move the pointer to the place where you want to put the text 
and click. After a moment the text will appear at that point. 

If you select cut again and copy text into a scrap, the 
previous text stored there will be erased. The text scrap 
only holds one block of text at once. 

If you want to leave a range of text intact but put a copy of it 
elsewhere on the page, use the Copy option. First, define 
the range by clicking at the first character to copy, hold down 
the button, and move to the last character. 

Select Copy from the Text menu. It will darken, indicating 
that you have selected some text. Then move the pointer to 
the place in the text where you want to copy it and click. 

Another feature of Personal Newsletter is the ability to 
change the style of the text. The style options available are 
bold, underline, italics and reverse. 
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To change the style of text select "Style" from the menu and 
click on the one you want. It will be highlighted. You can 
select combinations such as bold, italic and reverse and all 
will be highlighted in the menu. Click on a highlighted option 
to deselect it. Choosing "Plain" turns off all the other styles. 

Remember there is also a shortcut for selecting styles. Hold 
down the Commodore key (bottom left) and press the first 
letter of the style to turn it on. Press those keys again to 
turn it off. So if you press the Commodore key and "I" keys, 
Italic is turned on. 

You can either select the styles before or after you type in 
text. If you set the style to bold, all subsequent text that you 
type will appear bold until you change the style. 
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Later, if you want to highlight certain words or sentences in 
bold you can change the style of existing text. You have to 
define the range of text and then select the style options. 

Put the pointer at the beginning of the text to change and 
click so it flashes there. Hold down the mouse or joystick 
button and move the pointer to the end of the text. It is 
highlighted. 

Then choose the style from the menu as you normally would 
and the range of text will change to reflect it. 

There is also an option in the Style menu for centering text 
which works the same way as the other style options. 

Select the Center option (or press the Commodore and "C" 
keys) and press RETURN. The subsequent text you type 
will be centered within the column. Or you can define a range 
of text and then select Center. 

When Personal Newsletter loads it uses the system font 
called BSW. A font is the design of the text. There are 
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many fonts available in printing as you can see by looking at 
magazines. Fonts have names like "California" or "Roma." 

GEOS comes with different fonts so you can change them in 
a newsletter. You may have seen the font icons on the disk. 
These have to be on your Personal Newsletter work disk. 

Click on the Font menu option and the various fonts will be 
shown. The number of fonts displayed depends on how many 
font icons you have on your Personal Newsletter work disk. 

I PHOTO IWINDOW ! STYLE ! FONT !TEXT I PRINT ! FILE ! QUIT I 
t ..... ·.·.·.·.·.·.·.·.·· .................. , ............................... ; . ........... : .................. q ........... ................ {-......................................... ················2· ... •••••········ ...... -$ ... ......•••••........... j 

BSW 10 point 
University 12 point 

'" Calltorma >14 pomt 
Koma 16 pomt 
Cory 
Uwmelle 

These fonts come with the GEOS System disk and can be 
moved to the newsletter work disk. Setting up work disks 
was explained in the Getting Started chapter. 
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There is an asterisk next to the first font -- BSW -- which 
indicates that font is selected and whatever you type will be 
in that font. 

Move the pointer down the menu to pick another font. When 
you click on one, another menu opens that provides various 
font sizes, which are measured in points. Some fonts have 
more sizes available. For example: 

BSW (system font) 
University 
California 
Roma 
Cory 
Dwine1le 

9 point 
6, 10, 12, 14, 18,24 point 
10, 12, 14, 18 point 
9, 12, 18,24 point 
12,24 point 
18 point 

If you select California 14 point, that font will appear when 
you type, after you press RETURN. If you click on the Font 
menu again you'll see an asterisk next to the font selected. 
You can use various fonts in a newsletter. However you 
need to change to the font when you are ready to start 
typing. 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

Personal Newsletter Chapter 5: Creating Text 

Making 
Adjustments 

When creating a page, it's a good idea to pick a bigger font 
size and write the headline. You might pick University 18 or 
24 point. 

Then, when you begin typing the main text, you should select 
a standard font and size like BSW, 9 point. 

You should really avoid mixing a lot of fonts on a page, for 
two reasons. One reason is that fonts are memory hungry 

and they will use up all the available memory before you 
finish the page. But the second reason is because a mixture 
of fonts usually looks unprofessional. The page gets hard to 
read and confusing. 

If text doesn't fit into a window, you can usually make an 
adjustment to the window size and the text will reformat to 
fit. 

To adjust the size, click on "Window" and "Change Size." 
Then move to the window to change and click on it. Stretch 
or shrink the window to the size you want and click again to 

lock it. The text will reformat automatically. 
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You can also get text to automatically wrap around a picture 
in your newsletter. The process of bringing graphics into 
your page will be covered in the next chapter. 

Briefly, the way it works is that you open up a Photo window 
and place it in the text where you want a photo to appear. 
The text will wrap around the photo when it's inserted. And 
if you move the Photo window, the text will reformat 
automatically. 

You can see a preview of the page at anytime during the 
process of laying out a page or entering text. Click on "File" 
and select "Preview." A reduced facsimile of the whole page 
appears on screen. 

You don't have to wait until you finish a newsletter page to 
print it. At some point you should print a copy to see how 
it's going to look. 
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Saving 

Click on the "Print" menu and confirm that you want to 
proceed by clicking the OK button. Be sure your printer is 
hooked up properly and has paper loaded. 

If you printer doesn't respond, be sure the cables are hooked 
up correctly, that the "select" light is on, and that you have 
the right printer driver icon on the disk. 

If you have questions, refer to the chapter about printing as 
well as the information provided in the GEOS manual. If 

your printer works with the GEOS system, it should work 
with Personal Newsletter. 

You should never wait until you've finished a newsletter 
page to save it. The file should be saved at least once every 
hour in case the power is interrupted and the page you are 
working on is lost. 

Save a page by clicking on "File" and selecting "Save." The 
first time you save, enter a file name (up to 16 characters) 
and press RETURN. 
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1 

ENTER FILE NAME: 

Samplel 

I Cancel ~ 
rextscr~l~ ____ ~~----------~ 
can be pasted 
elsewhere on the 
page. 

Each time you save your progress, the file name will appear. 
Simply press RETURN to save with the same name (it 
replaces the older version of the page). If you want to create 
another file for the current page, change the file name by 
backspacing over it and typing a new name. Then press 
RETURN. The older version of the page stays on disk and a 
new file is created with the current version. 
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New Page 
When you have finished a page and saved it, you can clear 
out the screen by clicking on "File" and selecting "New." 
You'll be prompted to confirm that you want to "Clear This 
Page?" by clicking OK. This means erase the page from the 
screen -- not the disk. 

In a few moments, you'll have a clean page to start the next 
newsletter page. 

Those are all the features available for entering text into your 
newsletter or document. 

The next chapter is devoted to creating graphics and how to 
merge the two. If you have questions about entering text or 
need more information, refer to the sample newsletter in the 
upcoming chapter. 

81 



82 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

Personal Newsletter Chapter 6: Creating Graphics 

Chapter 6: 
Creating Graphics 

The other half of creating a great looking document is the 
ability to merge in graphics. 

With Personal Newsletter, you can create original artwork 
with geoPaint or use the clip art disk provided with the 
Personal Newsletter. You can also get additional Personal 
Newsletter Clip Art disks from your dealer or use clip art 
from Print Shop. You can even use digitized images created 
by video cameras. 
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This chapter will begin with the process of creating Photo 
windows on a page in Personal Newsletter. You will see 
how a photo album is used and how the pictures are put into 
the window. 

Then the chapter will review how to create more art using 
geoPaint. And how to use the Photo Manager to create more 
Photo Albums. If you are familiar with these two GEOS 
applications, you can skip this section. 

Finally, this chapter will describe how to import graphics 
from other clip art disks like Print Shop. 

The Photo Album that comes with the Personal 
Newsletter disk contains a number of clip art pictures. 
You can put these directly into a newsletter page or 
move them into geoPaint and customize them. 

This album is called "Personal" and should be installed 
on the work disk. From the desktop, insert the Personal 
Newsletter work disk and make sure the icon called 
"Personal" is on it. If it isn't go back to the Personal 
Newsletter master and transfer it to the work disk. 
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Photo 
Windows 

Next, load Personal Newsletter. When the page appears 
with the menu at the top, click on the "Photo" option. 

The photo window is similar to a text window except it 
will accommodate a picture. Select "Create" and move 
the pointer to the place on screen where you want the 
picture to appear. 

Click once to lock the left corner and then stretch the 
window to the size of the picture you'll be inserting. (If 
you make a box the wrong size it can be changed later.) 
Then click again to lock the window size. 

Whenever you create a Photo window the art in the 
"Personal" album (or whichever album is on the work 
disk) will be displayed, one at a time. 
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PHOTO I WINDOI .. I .,. 1 "'1"'1 + 1 _I 9 NT I FILE I QUIT I 67% Free 

o I I 1 I 2 I 3 

0 

mJ Time is running out --. only 363 shopping days until 
Christmas. 

-
1 

-
2 .. 

The first picture is displayed and a new menu opens at 
the top. The arrows allow you to move the picture within 
the frame, to better center or crop it. 

If you click on plus and minus, the next or previous 
pictures in the album are displayed in the window. Each 
picture is numbered and a print out is included with the 
Personal Newsletter package. 
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Personal Newsletter Chapter 6: Creating Graphics 

Text Wrap 

geoPaint 

If you hold down the button on the plus or minus sign, you 
can quickly go to a specific picture. Refer to the clip art 

book to choose the photo you want and note its number. 

The picture number is displayed to the right of the menu. 
These change rapidly when you hold the button down, so 
you can get to the picture you want quickly. 

You can open up a total of twenty windows on a page and 
they can be placed anywhere. 

If you put a Photo Window in the middle of some text, the 
text will automatically wrap around the picture. If you 
move the Photo Window, the text will reformat again. 

If you want to break up a long section of text, open a 
Photo Window and place it in the text. Select the photo 
and crop it using the arrows at the top. Hold down the 
button on the up/down arrows to move the picture faster. 

If you want to create your own graphics or touch up existing 
ones, use the geoPaint program that comes with the GEOS 
disk. 
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The art you create can be stored in the Personal Newsletter 
photo albums or you can create new albums. 

Detailed instructions for using geoPaint are included with the 
GEOS system manual. If you are not familiar with the 
program, you should review those instructions. 

The next few pages review some of the program's highlights 
for you. 

When you load geoPaint, you'll first be asked if you want to 
create a new document or open an existing one. 

If you select "Create" you'll be prompted to enter a name (up 
to 16 characters) and press RETURN. 

If you select "Open" a list of existing file names will be 
displayed. Highlight one and click on "Open." 

When geoPaint opens the screen should look like this: 
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The center of the screen is the drawing area. On the left side 
are drawing tools. At the bottom are colors for drawing. 
Personal Newsletter doesn't use color so you can switch it 

off by clicking on "Options" and selecting "Color off." 

The bottom will change to show various options according to 
the tool you are using. For example, when drawing a 

rectangle, it provides the measurements. 
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This is a brief rundown of the drawing tools: 

When you load the program the left quarter of the page is 
displayed. The arrows are used to move around the page so 
you can work on different areas. 

The position of the screen on the page is shown at the 
bottom. 
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Click on the line tool. Move the pointer to the place you I 
want the line to begin and click. Move the cursor to draw the 
line and click again when complete. 

I -
Free hand lines can be drawn using the pencil. I 
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Brush 

Brush Size 

Circles 

The paint brush is used for free hand drawing of lines in 

various sizes and shapes. 

Click on the "Options" menu and select "Change Brush" 
from the menu. Then choose a shape and thickness by 
moving around the box at the bottom of the screen. Click 

on the style you want. 

0- -II .• •• ' / / / ... '-. "' " 
I I I I ---- ................ .. 

To draw an circle, select the circle tool and move the 

pointer to the place where you want the center to be. 
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Rectangles 

Text 
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Then move the pointer to stretch the circle to the size you 
want it.and click to lock it. You can also draw a filled circle 
using the other circle tool. 

. Click on the rectangle and place the pointer where you want 
the rectangle to begin. 

I I 
Move the pointer to stretch the rectangle into the size and 
shape you want it and click to lock it. 

Text can be entered in geoPaint, however it's not the same 
as text in Personal Newsletter. On a Personal Newsletter 
page text can be changed, edited and refonnatted. Here, text 
is treated like a graphic. Text created here should be used to 
add to a picture, not as normal text in a newsletter. 
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Text Style 

Fonts 

Select the Text tool by pressing the "T." Then designate a 
rectangular area by clicking on screen and moving the 
pointer. When the rectangle is large enough to accommodate 
the text, click again. The pointer turns to an I beam, 
indicating that you can type. 

ABCDEF 
If you make a mistake when you are typing, press the delete 
key to backspace over the letters. Once you click the button 
again, text becomes a graphic which you can't backspace 
over. 

At the bottom of the screen you can pick the style of text you 
want -- bold, italic, underline, outline, reverse -- by clicking 
in the boxes. 

Fonts can be changed as well. Pull down the "Font" 
menu and pick from the ones in the system. Then select 
the point size. This is the same process as selecting 
fonts on a Personal Newsletter page. 

You can also copy a block of text or cut and paste it, 
using the menu option. 
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Select the ruler to measure the length of a graphic. Click 
at the beginning and stretch the length of the object. 

Fill any enclosed area by selecting the Faucet and 
clicking on the area. It will fill in with black but you can 

change that to other patterns (see below). 
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Patterns 

Erase 

Editing 
Graphics 

You can paint, spray or fill an area with one of the 32 
patterns available . ... -. __ -.-__ .-.-.-.-.-. __ -.-.-. __ -__ .-.-. __ -__ -.-.-IIIIIiI.-....._ ... 
--~---~~---lID--m----.---- --- -- - ------e:-:- 8 -:::-- -:- -::a-:-:-:: ------ --- --- -- - ---~ ------------------------------_.----------------------____ -_1 ------------------------------
Click on the box at the bottom left corner to display the 
patterns and click on one to choose it. When you use the 
brush, spray paint or fill, the pattern will be used. 

The other end of the pencil is an eraser. Select this and 
move the square to the screen. If you click once, the square 
turns red and will erase when you move the square. To stop 
erasing and move to another position, click again and the 
square turns blue. Click again to turn the eraser on again. 

A rectangular area can be moved, copied, inverted, cleared, 
rotated or flipped. Choose the Edit box. 

Move the pointer to the top left corner of the area you are 
going to define with a rectangle and click. Then stretch the 
rectangle to size and click again. The menu at the bottom 
provides the editing options. 
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Edit Mode • Move o Copy 

o Mirror X [J Invert [J Clear 
o Mirror Y [J Rotate 

If you change your mind you can undo the last thing you did. 
"Undo" will undo only the last action. If you fill an area with 
a texture you don't like, press undo right away to remove it. 

The Pixel Edit tool under the Option menu can help you fine 
tune a graphic and touch up work. It magnifies an area of the 
drawing so you can make changes one pixel at a time . 

•••••• •••••• •• •••• •••• •• •• •• 
A box is displayed over a part of the graphic which is the 
area that is blown up. This can be moved to an area to edit 
using the pointer. To go back to the standard drawing size, 
click on the Option menu and select "Normal Edit." 
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Moving 
Graphics 
to Albums 

This is a quick overview of using geoPaint. There are more 
details and shortcuts that can be learned by reading the 
GEOS system manual. 

When you finish creating a graphic, move it to a photo album 
so it can be used in Personal Newsletter. 

1. Select the Edit box from the tools. Click at the top left 
corner of the picture and stretch the dotted line around it. 
You can grab a whole picture or use the rectangle to crop 
the part you want. Click once to freeze the rectangle. 

2. Select the Edit menu at the top of the screen and choose 
the Copy option to copy the picture into a scrap file. 

3. Click the geos menu and select "Photo Manager." Y ou'll 
be asked if you want to open an album or create a new 
one. Existing album names are displayed. If the 
"Personal" album is on the work disk, it is displayed 
here. Click on the name and on the Open button and the 
first picture in the album is displayed. 
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Using Photo 
Albums 

98 

4. The album has a small menu bar on it. Click on "Edit" 

and select "Paste." The photo scrap that you took from 
geoPaint will be pasted into your Photo Album and be 

accessible when you create a photo window. 

~ 
I 

1 of 5 

A Photo Album can have up to 127 pages of pictures. And 

you can create as many albums as you want. But you should 
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use care in organizing pictures so it's less work to get them 
onto a newsletter page. 

When you create a photo window, Personal Newsletter 
looks for the first album on the work disk. More than one 
album per disk is not recommended. 

There are two approaches to handling pictures. You can put 
all pictures you create into the same album. When you 
create a window you can scan through and pick the picture 
you want by number. 

Or you can put pictures into various albums. When you need 
to use one, put the album on the work disk for the page you 
are creating. 

A newsletter page doesn't actually store pictures. It goes 
out and gets them from the photo album when it needs them 
for display or printing. This saves disk and computer 
memory space. 

It means that you have to keep the photo album and the 
newsletter page together on the same work disk. 
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It also means that if you add pictures to the beginning of an 
album it will change the order of the existing ones so a 
different picture may appear in a newsletter. This is unusual 
since an album that was used with a page normally remains 
unchanged on the work disk. New pictures are usually added 
to a master photo album which is copied to a work disk when 
a new page is created. 

Personal Newsletter will also allow you to import graphics 
that were created by other programs. 

There are three utility programs on the Personal Newsletter 
disk that are used for importing or converting existing art: 

"Import," "Scrapper" and "Convert." 

Each has a different function. Refer to the chapter called File 
Management for instructions. 
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Chapter 7: 
Printing 

The best part of creating a newsletter is the moment when 
the first copy comes off the press, or, in this case, the printer. 

Printing Personal Newsletter pages is just like printing 
documents created by GEOS programs like geoWrite and 
geoPaint. If your printer is configured and working for GEOS, 
you won't need to make any adjustments for Personal 
Newsletter. 
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Like GEOS programs, you'll need to have a printer driver on 
the work disk. GEOS comes with many drivers. You should 

keep only the driver that your printer needs on the disk. 

There are many combinations of printers and printer 

interfaces available for the Commodore. If your printer is not 

named, it probably works like some other printer listed. 

There is a Printer section in the Appendix that provides more 
detail. Refer to the GEOS manual for a list of printers and 
interfaces. It also provides information on switch settings. 

Once your drivers are set up, you can print a newsletter page 
when it is loaded in Personal Newsletter. To load Personal 
Newsletter, insert the work disk in the drive and click on the 

disk icon. Then double click on the Personal Newsletter icon. 
Or you can double click on the page you want to print. Both 
the program and file will load. 

Personal Newsletter pages can be printed during the process 

of designing and creating a page. You can see what the page 

will look like before you print it using the Preview feature. 
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Printing 
A Page 

Click on the "File" menu and select "Preview." A reduced 
facsimile of the whole page will be displayed on screen so 
you can see what the page will look like when it's printed. 

PHOTO I WINDOW I STYLEI FONTI TEXT I PRINTI FILE I QUIT J 100% Free 
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When you are ready to print your newsletter page, click on 
the "Print" menu and confirm it by clicking the OK button. 
Be sure the printer is turned on and the paper is aligned. 
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Trouble 
Shooting 
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If the printer is not working, there are a number of possible 

solutions. These are some symptoms and recommendations. 

If nothing is happening: 

1. The printer drivers provided with the GEOS system 

should work with all GEOS compatible documents. If 

your newsletter page is not printing, try printing a sample 
from another program such as geo Write to determine if 

the hardware is correctly configured. 

Refer to the GEOS manual to configure your printer to work 
with GEOS .compatible programs. There is information about 

how to set up your specific printer and interface. 

If the printer doesn't work with any GEOS program and you 

can't find the information in the GEOS manual, the publisher 

of GEOS, Berkeley Softworks, has a customer service 

department that may be able to help you. Their number is 

(415) 644-0890 and they are available between 9 am and 5 

pm Pacific time. 
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2. Make sure the printer is turned on. 

3. Check that it is "on line" or selected. This is usually a 
button or switch on top of the printer. 

4. Be sure the removable top of the printer is securely in 
place if that is required for the printer to be on line. 

5. Check to be sure you've picked the correct driver. If your 
interface or printer is not on the list in the GEOS 
manual,check the printer and interface manuals to see 
which one on the list the hardware emulates. 

6. Check the cables to be sure they are firmly plugged into 
the computer and printer. 

7. Check the DIP switches on the printer and interface. If 
they have been changed from the factory positions, try 

resetting them. Each time you reset a switch, turn off the 
printer to clear the old setting from the printer memory. 

8. Restart the system. Turn off everything. Then turn on 
the printer first, followed by the computer. 
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If everything is printing on the same line or leaving too many 
spaces between lines: 

Check the printer and interface DIP switch that controls 
"Line Feed" or "Carriage Return." If the printout skips lines 

while printing, then the line feed switch might be turned on. 

Personal Newsletter provides a line feed so the switch 
should be off. 

If the printer is skipping lines, acting up: 

If the printer is beginning to skip lines or not print very well, 
then it might be heating up. Pages with a lot of graphics can 
cause the print head to heat up. If you are working the 
printer hard, give it a break and let it cool down. 

If the print quality is deteriorating: 

Generally when you print out a newsletter you will probably 

use it as "camera ready" copy that will be laid out on boards 

and sent to a printer or photocopier for reproduction. 
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Therefore it's important to get a clean, crisp printout so the 
copies will be readable too. 

The quality of the printout depends a lot on the ribbon you 
are using. The ribbon moves past the print head where it is 
struck against the paper to leave an ink impression. 

An old ribbon doesn't have enough ink left on it so the quality 
of the printout is probably going to be faint. It's time to 

change the ribbon if your printouts look washed out. 

On the other hand, a new ribbon might have a little too much 
ink on it to give you a crisp print out. If the letters or 
graphics are filling in with ink, you might want to use the 
ribbon for word processing or something else for awhile 
before printing the newsletter. 

Some printers like an Okidata, cut off the right edge of the 

newsletter because the Okidata uses a different pixel size. 
You should check this when you first set up the page by 
doing a test printout. If the edge is trimmed, you can make 
the right columns a little narrower to accommodate the 
difference. 
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108 

Finished? Just click on "Quit" and confirm you want to stop 
using Personal Newsletter. You'll be returned to the 
desktop. Remember to save your page before quitting. 
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Chapter 8: 
File Management 

The 
Desktop 

Between GEOS and Personal Newsletter, there are a lot of 
different file types and options. Therefore this chapter is 
devoted to giving you information on saving, copying, moving 
files and keeping track of what you have. 

Generally the first thing you see when you are using 
Personal Newsletter is the GEOS desktop. There are a 
number of file and disk management functions that can be 
performed here, as follows. 
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Files on 
Disk 
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If you insert a disk into the drive and .click on the disk icon all 
the file names will be displayed. The icons indicate the type 
of file each is. For example, Personal Newsletter is a 
newspaper, a newsletter page has "Extra" written on the 
icon, and a printer driver is a small printer. 

NEWS 
Soft 
S c 

Newsletter 
~ 

Page 1 Desk Top 

c[!J, ~ IJ c[j 
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Disk 
Options 

If you click on the "Disk" menu these options are available: 

You can open or close a disk. When you select "Open" the 
file names and icons are displayed. You should close a disk 
before removing it from the drive. 

You can rename a disk. Disk names are displayed at the top 
of the disk notepad. You can select this option, delete the 
old name and type in a new one, up to 16 characters long, and 
press RETURN. Never use disks with the same name. 

Disks can be copied by selecting that option from the "Disk" 
menu. You'll be prompted when to insert the source 
(original) and destination (copy) disk. 

If you have two disk drives, select "Add Drive" from the 
"Disk" menu. The prompts will tell you to turn off the 
original drive, turn the second one on and then turn the ftrst 
one on again. 
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Format a disk from the "Disk" menu. This prepares a disk to 
store data you are going to create. Be sure to use a new 
disk or one with files you don't need. 

During the process of creating newsletters, you'll want to 
move files around, make copies, rename them or remove 
them from disk. Use these file options to do so. 

A Personal Newsletter file can be opened or loaded from the 
desktop by clicking on it's icon once, then clicking on the 
"File" menu and selecting "Open." A shortcut is to simply 
double click (quickly) on the icon and it will load. 

You can copy a file by selecting it (clicking on it once so it is 
highlighted) and picking "Duplicate" from the "File" menu. 
Enter a new file name and press RETURN. 

Files can be renamed too. Click on the file icon once and 
select "Rename" from the "File" menu. Enter the new name 
and press RETURN. 
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Copy Files 

Some information about each file, like its type and size, is 
stored and can be viewed by clicking on the file icon and 
selecting "Info" from the "File" menu. You can write protect 
a file. If the box is open, it means the file can be removed 
from disk. If you click on it to make it solid, it can't be 
removed. 

Often you'll need to copy a file from one disk to another, 
particularly when you create a work disk. This is covered 
next. 

To do so, click on the file you want copy and pause. Then 
click on it again. A blue "ghost" of the icon should appear. 
Move that to the border below the disk notepad and click. 
The icon should appear in the border. 

Next, insert the disk where you want to copy the file and 
click on the disk icon to display the file names. Click once on 
the file you want to move, pause and click again to get the 
ghost back. Then move it to the disk and click. The program 
will prompt you to insert the disk where the file was and then 
the current disk so the file can be copied. 
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After it's copied, insert the first disk again and move the icon 
back onto the disk notepad. Now you have a copy on each 
disk. 

In the chapter about getting started, it explained that you 
should set up work disks, with any files you need when 
creating a newsletter. 

Putting together work disks is simply a matter of copying 
files to the various disks, as described above. 

Typically a Personal Newsletter should have the program, a 
photo album, a printer driver, an input device driver, the 
desktop (optional), the fonts you'll use in your newsletter, 
and any newsletter pages you might be working on. 

You can have many different Photo Albums but you can only 
use one at a time. And the one you used to create a 
newsletter page must be on the same disk as the page. This 
means you sometimes have to move pictures from one album 
to another, which is explained later in this chapter. 
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Moving 
Photos 
To Albums 

Another work disk can be created for graphics management. 
This might include other photo albums, geoPaint, the Photo 
Manager, the Personal Newsletter Import, Scrapper and 
Convert programs and any clip art conversions you might do 
from Print Shop disks. 

You can move a photo from geoPaint into a Photo Album as 
follows: 

1. Select the Edit Box tool and surround the part of the 
picture you want to put in the album. 

2. Select "Copy" from the "Edit" menu 

3. Click on the GEOS menu and pick "Photo Manager." 

4. Either open an existing album or create a new one. 

5. Select "Paste" from the "Edit" menu in the Photo 
Manager and the photo will appear. Close the album by 
clicking on the box at the top left. 
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You should organize your pictures according to how you use 
them so you can avoid having to move them to different 
albums. It's a good idea to print out each picture and keep a 
record of it's number in the album so you can find it quickly 
when using Personal Newsletter. 

There are other times when you'll just want to move pictures 
from one album to another, and don't need to use geoPaint. 
For example if you wanted to move a picture from Album A 
to Album B: 

1. Select the Photo Manager when the desktop is loaded 
and open Album A. 

2. Go to the picture you want to move by flipping the pages 
and select "Copy" from the "Edit" menu. Close the 
album. 

3. Select the Photo Manager again from the GEOS menu 
and open Album B. 
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Importing 
Art 

4. Select "Paste" from the "Edit" menu and the picture you 
copied from Album A will appear here. Close the album. 

There are other sources of art that you can use with Personal 
Newsletter such as clip art disks, pictures created with a 
digitizer or other graphics. The Personal Newsletter master 
disk has three utility programs on it that can make art from 
those sources usable with your newsletters. 

If you have a disk with graphics on it, but it is not a GEOS 
disk, you will probably get a message to that effect when you 
try to read the disk directory from the GEOS desktop. 

GEOS has to convert the fonnat of a non-GEOS disk first so 
the file names are displayed as folders on the GEOS 
desktop. This is how to do that: 

1. First make a copy of the art disks you want to import. 

2. Load the GEOS system. 

3. Put the clip art disk copy in the drive and click on the disk 
icon to get a list of the files on it. You'll get a message 
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saying this is not a GEOS disk. Click yes to make it into 
one. The file names will appear in GEOS type folders. 

There is a utility called "Import" that moves graphics files 
into geoPaint. Art that is stored in Commodore graphics files 
can be imported into photos that can be used in Personal 
Newsletter. 

These could be pictures created with a digitizing device such 
as Computer Eyes or other programs. 

1. Insert the Personal Newsletter master disk and copy a 
file called "Import" from it to the clip art disk. 

2. Copy geoPaint to the clip art disk too. 

3. Double click on the "Import" icon and a list of the pictures 
will be shown. Click on the one to import and on the 
"Open" button. It will be displayed on screen and written 
to disk as a geoPaint file. You will be prompted to click 
OK if you want to invert the photo which can improve its 
appearance. 
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Scrapper 

4. From the desktop, load geoPaint and then the file you 
imported. You can use the standard process to move the 
art (or a section of it) into your Photo Album. 

To review moving art into a photo album, use the Edit Box to 
select the picture, click on the "Edit" menu, choose "Copy." 
From the GEOS menu, choose "Photo Manager" and open 
the album. Select "Paste" from the album's menu and the 
picture will appear in it. 

Another method of importing art is to use the Scrapper. This 
creates a file that can be loaded directly into a photo album 
without using geoPaint. This is used when you want to grab 
a large picture that needs no editing. 

1. Click on the Scrapper icon and open the file you want to 
convert. The image will be displayed full screen. 

2. When you return to the desktop, select the Photo 
Manager from the GEOS menu. 

3. Open the photo album that you want to store the 
imported picture in. 
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4. Select "Paste" from the "Edit" menu. A portion of the 
picture will appear in the album, but if you load a Personal 
Newsletter page and put this picture in a photo window it 
will be full sized. You will be prompted to click OK if you 
want to invert the photo which can improve its 
appearance. Note that this creates a large file, about 9K. 

You can also import art from the many clip art disks that are 
available for Print Shop, using the "Convert" program 

Double click on the "Convert" icon, The program will prompt 
you to insert the Clip Art disk you want to convert. 

The names of each piece of clip art on a disk will be 
displayed. You can select the ones you want to convert by 
highlighting each and clicking on the Yes button. 

Each time you select a picture, the counter will increment. 
When you finish, click on the Quit button. The program will 
create a file for each picture with the same name as the 
original file. 
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Storing 
Pages 

Loading 

The Convert utility is capable of converting up to 40 Print 
Shop pictures into geoPaint format. Then you can edit them 
as you wish using the standard geoPaint tools. And they can 
be pasted into Photo Albums for use with Personal 
Newsletter. Be sure to have plenty of room on your work 
disk because this can create a file as large as 20K if you 
select a lot of pictures at once. 

Newsletters are created and stored by page. During the 
process of creating a page, you should be periodically saving 
it. That way, if there was a power failure or other 
interruption, the work you've done up until the last save 
would still exist. 

To load a newsletter or a template select the File menu and 
Load. A list of files is displayed. Highlight one and click on 
"Open." 
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To save a newsletter, click on the "File" menu and select 
"Save." Enter a file name, up to 16 characters long. Then 
press RETURN and the page is saved onto the work disk. 

Later, as your work progresses, select the Save option again 
to update the file on disk. Instead of being prompted for a 
name, the program will display the existing file name. Press 
RETURN to replace the file on disk with the latest version of 
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Newletter 
Templates 

the newsletter. If you want to create another file for the 
page, backspace over the file name and enter another one. 
The original file remains the same. 

1 

2 

ENTER FILE NAME: 

Samplel 

I Cancel ~ 
text scnlIJ-. __ ..,...,...-----...,..­
can be pasted 
elsewhere on the 
page. 

If you use the same format but change the contents of the 
newsletter periodically, then you should create a "template" 
or standard page layout. 
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Normally when you use a template you load the file, say 
"Temp" and fill in this month's news. After a while you will 
want to save your work to date but you don't want to save it 
as "Temp" because this will replace your "clean" template 
with the current month's newsletter. 

Instead, select "Save" and change the file name to something 
like "News9!89." The page will be saved with the new name 
and the "Temp" template file will remain unchanged. 

When you are done working on a page and you have saved it, 
you might want to clear it out and start a new page. This is 
done by selecting the "File" menu and "New." You have to 
confIrm this by clicking OK. Be sure to save your current 
page before clearing it. 

A disk should be closed before removing it from the drive, 
unless you are instructed to do so by a dialogue box. 

Don't use the same name on two disks or files. 
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GEOS 
Questions 

Always create work disks. 

Close the disk drive door after you insert a disk. 

Most of the File Management routines are part of the GEOS 
system. If you have problems and don't find the answer here, 
check your GEOS manual. Berkeley Softworks, the 
publisher of the GEOS system software, often updates the 
system and makes upgrade available to customers. 

If you have any problems related to the GEOS system or 
need information about GEOS system updates, you can talk 
to their customer service department at (415) 644-0890 
between 9 am and 5 pm Pacific Standard Time. 

125 



126 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

Personal Newsletter Chapter 9; Sample Newsletter 

Chapter 9: 
Sample Newsletter 

This chapter is devoted to building a newsletter page from 
scratch, step by step. This page uses about all the features 
of Personal Newsletter so if you build this one you'll be a pro. 

The newsletter is called "Photo Phinish" and it's a gossipy, 
information monthly about photography as art. 

If you want to look at the finished version of the front page, 
it's stored on disk as "PhotoPhinish." Load it and print it so 
you can follow the progression of actually building it. 
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When you start a page you should pull together all the 
pictures you think you'll want to use and get them into the 
Photo Album that will be on the newsletter disk. 

You might need to move some photos from different albums, 
draw some new ones, import graphics from a digitizer or 
convert Print Shop pictures. This process is called Art Prep. 

Before starting the newsletter page, there is a picture that 
we will need to create using geoPaint which needs to be 
loaded into the Photo Album. (It's already in the "Personal" 
album on your work disk if you don't want to create it.) The 
other pictures we need are already in the album. 

Load the GEOS system disk. When the desktop appears, 
insert a disk with geoPaint and load it. This might be your 
"art work disk" that you use when editing or creating 
graphics. 

Create a new document at the prompt which you can call any 
name. Now you are ready to create the logo for the "Photo 
Phinish" newsletter that you can use each time you write the 
newsletter. 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

Personal Newsletter Chapter 9: Sample Newsletter 

The logo in this example is going to be hand drawn. You can 
do anything you want to create the logo here and the results, 
of course, will depend on how good you are doing free hand 
lettering. This is intended to illustrate how you can use 
geoPaint to create a newsletter logo that is distinctive and 
can be used over again. 

Double click on the Paint Brush tool on the left of the screen. 
The bottom of the screen will display the brush shapes 
available. 

G- • II .•• e ' / / / .. '- '-" 
I I I I ---- ............ .... 

For this sample, select the broad stroke brush that slants to 
the right by moving the pointer over it and clicking. 

Now, starting at the top left of the screen, draw the title 
using the brush. Practice a few times to get the feel of 
moving the brush. 
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If you want to erase a practice run, double click on the Eraser 
and the whole screen will disappear. If you make a mistake 
and want to back up one step, click on the Undo button and it 
will erase the last piece drawn. 

If you don't like the brush shape, double click on the brush 
again and select another style. 

Once you are satisfied with the results, you need to paste it 
into a photo album. 

As mentioned earlier, you should keep an Art Work Disk 
with geoPaint, Photo Manager and the Personal Newsletter 
graphics utilities on it. This disk should have a "work photo 
album" on it which you can use to store the art you create. 

Later, photos can be transferred from the "work photo album" 
into the other albums you may keep by category. This is an 
example of storing the logo in this album until you get around 
to moving it into the "Personal" Photo Album. 

Click on the Edit Box and surround the whole graphic with a 
rectangle. Click on the "Edit" menu and select "Copy." 
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Move Photo 
Between 
Albums 

Click on the geos menu and select "Photo Manager." Open 
the album. If you don't have one open on this art work disk, 
select "Create," enter an album name and press RETURN. 

Select "Paste" from the "Edit" menu of the photo album. The 
Photo Phinish logo will appear in the album. 

You can close the Photo Manager, quit geoPaint and go back 
to the desktop. 

After working on graphics with your art work disk you may 
need to move pictures stored in the photo album to other 
photo albums. For example, the logo just created should be 
moved to the "Personal" photo album. 

Move the "Artwork" album to the Personal Newsletter work 
disk which has the "Personal" photo album on it too. 

Select the Photo Manager option from the geos menu and 
open the "Artwork" album. Find the logo and choose the 
"Copy" option from the album menu. Close the album. 
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Now, in the "Photo Manager" open the "Personal" album and 
select "Paste" from the menu. The logo will appear in the 
album. Close the album. 

From the desktop, select the "Artwork" album and throw it 
away. You can only have one album on each work disk. 

From the desktop, with the Personal Newsletter work disk 
in the drive, load the program. When the empty newsletter 
page appears, you are ready to begin. 

The Commodore computer has a set amount of memory and 
you can run out of it before you get everything on a page if 
you aren't aware of how the various elements use memory. 

You've probably noticed the" 100%" message at the top right 
of the screen. That number keeps track of how much memory 
you have left and gets smaller as you create the page. 

The maximum number of windows you can have is 20. That 
is any combination of photo or text windows. 
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Fonts 
The "BSW" 9 point font and "University" 6 point font are part 
of the system so they take up very little memory. You 
should use BSW for the body text of a page for maximum 
memory efficiency. 

Other fonts use more memory. Avoid using many different 
fonts on a single page. Each font you load will eat up some 
memory. When the memory reaches 30% left on a page, the 
program won't accept any more fonts. The appendix contains 
a section with a chart of how much each font and font size 
uses. You can refer to this when you begin a design. 

Graphics designers usually point out that using many fonts 
on a page is not recommended for a clean, stylish looking 
document. Mixing fonts often creates a confusing page that 
is hard to read. Refer to the "Design Hints and Tips" chapter 
for recommendations. 

Changing the style of a font that is loaded does not use much 
memory. So you can mix plain, bold, underline and reverse 
styles freely. 
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Styles should be used with restraint as well. They are used 
to communicate a point. For example Bold is used for 
emphasis. If you use it too much, it loses its impact. Mixing 
a lot of styles in the text usually makes the page look messy. 

Photos don't use much space in memory because they are 

stored on disk and automatically retrieved when needed. 
You can use a lot of pictures in your newsletters which 

makes a page all that much more interesting. 

Using the right mixture of elements means you won'trun 
short of space and you'll have a sharp looking page. 

First, set up windows in the form of the newsletter layout. 
Since many of the windows in this newsletter have photos in 
them, you'll also be putting in your pictures as you go along. 
Windows can be moved or resized as you go along so the 
layout you first create isn't cast in stone. 

Click on the "Photo" menu and select "Create" to set up the 
first photo window .. Move the pointer to the top left and 

click once. That locks the left corner of the window and a 
small square appears. 
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Stretch the window to the right side of the page until you 
reach the 2.3" mark on the top ruler and down until you reach 
the 2" mark on the side ruler. It might take a few seconds for 
the rectangle to catch up to your pointer movement. 

Click again to lock the window. This is for the first picture 
that will appear in the newsletter banner. 

PHOTO 67% Free 

o 3 

o 

:~ .:~;-.: 
~ .... 1: ! . 

1 

2 
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The first picture in the Photo Album appears in the window. 
If it's the picture of the woman, you can adjust its position in 
the window using the arrow keys at the top of the screen. If 
you move the pointer over the up or down arrow keys and 
hold down the button, the picture will move faster. 

If it's not the first picture, press the plus ( + ) sign on the 
menu to scan through the album. If you put the pointer on the 
plus sign and hold down the mouse or joystick button, the 
program scans quickly through the album, displaying photo 
numbers. If you know what number the picture is, you can 
get to it fast using this technique. 

Once you select the picture and position it, it will lock into 
place when the pointer is moved off the positioning menu. 

The next part of the "Photo Phinish" banner is made up of the 
logo you created in geoPaint. Create a Photo Window (click 
on "Photo" and "Create") to the right of the first picture. 

Move the pointer to the 2.5" mark on the top ruler and click 
once. Stretch the box to the 5" mark at the top and down to 
2" so it lines up with the bottom of the window on the left. 
Click again to lock its size. 
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Text 
Windows 

The same picture from the photo album will appear in the 
window. Click on the plus sign at the top of the screen until 
the photo you want -- the Photo Phinish logo -- appears. 

Use the arrows if you need to adjust the position of the 
picture. Or, if the window isn't the right size, use the 
"Change Size" option in the "Photo" menu. 

Next, create a third photo window at the top of the page. 
Click on the "Photo" menu and select "Create." Move the 
pointer to the 5.3" mark on the top ruler and click. Stretch it 
across to the 7.5" mark and down so it's even with the other 
box and click again to lock it. 

Use the plus sign to go to the picture in the album -- the 
male -- that you want to insert here. 

You can move a window or change its size anytime or even 
remove it from the page. Just click on the "Photo" menu and 
select the appropriate option. 

The next windows you open will be for entering text. 
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There are three stories on the front page so you should open 
up three windows to accommodate the text. More photo 
windows will be added later so that the text will wrap around 
the pictures. 

Click on "Window" and select "Create." Move th~ pointer to 
the left side of the page underneath the banner and click. 
Then stretch the window down to the 5" marker on the side 
ruler and over to the 4 1/2" marker on the top ruler. Click 
again to lock the window size. 

Go below that and create another text window. This should 
start below the window you just created and extend to the 
bottom of the page. It should be the same wIdth. 

The third window starts to the right of the two windows at 
about the 4 1/2" marker on the top ruler. It extends to the 
right side of the page and down to the bottom of the page. 
When finished your layout should look something like this if 
you select the Preview option: 
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Save 
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If you don't like the way the page looks, you can move a 
window or change its size anytime or even remove it from 
the page. Just click on the "Window" menu and select the 
appropriate option. 

This is also a good time to stop and save your work to date. 
Click on the "File" menu and select "Save." Enter a file 
name, up to 16 characters, and press RETURN. 
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If the front page of the "Photo Phinish" newsletter is always 
produced in this format, then the copy you just saved might 
serve as an excellent template. You should keep it "clean" 
by saving the page under a different name as you work on it. 
For example, the first time you create the page to this point 
you could save it as "Photo 1 Temp" to designate it is a 
template of Page 1 of Photo Phinish. 

When you load it up to do this month's issue, create the 
current page 1 and save it as "PhotolJan" for example; That 
will leave the "Photo1Temp" file untouched and you can load 
it up next month to create "PhotoIFeb" and so forth. 

You can type the newsletter text right into the columns. 
While typing you can select different type fonts and styles by 
clicking on the menus above. A void more than one or two 
fonts but change the style of the font as needed. 

Begin in the right hand column by moving the pointer to the 
window and clicking in it. A cursor should be flashing in the 
left corner, indicating that you can type there. 
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This story begins with a headline, so you need to click on the 
"Font" menu to change the size. All of the text on this page 
was typed in "Roma." The BSW default font takes up less 
memory, but Roma can be used for this page if you prefer it. 

From the Font menu, select the Roma font. Then select 18 
point because the first couple of lines are a headline and the 
type should be large. 

Next, click on the "Style" menu and select "Bold." Press 
RETURN and type the headline on two lines: 

So, You Wanna Be a 
Fashion Photography Star 

After that the text will be normal size. So select "Roma" 
again from the Font menu but change the size to nine point. 
And change the style back to Plain. 

Then type all the text in. The complete newsletter is stored 
on disk as "PhotoPhinish" if you don't want type the text in. 
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So, Yon Wanna Be A 
Fashion Photography Star 

If you've been going to the movies or watching TV 

- lately you've probably got the idea that the very pinnacle 
3 of photographic stardom is the New York or Los Angles 

based fashion photographer. 
It seems like a world of glamorous locations, beautiful 

people, big bucks and recognition in your field. 

Life in the Fast Lane 

We interviewed some of the best known people in the 
- fashion business and found that, yes, if you suceed all 
4 those perks you hear about are true. 

The next window to enter text into is the story on the left side 

about the model turned photographer. 

Move the pointer over to that box and click. The cursor will 

appear at the top left of the box where you can begin typing. 

Another headline should be typed here so select "Font" and set it 

to "Roma --18 Point." Keep the style plain instead of bold like 
the last one. 
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Cut, Copy, 
Paste 

Now type the headline: 
Once a Successfui Model, Now 
On the Other Side of the Lens 

Then choose Fonts again and change the Roma font back to 9 
point size and continue typing the text. 

You can define a range of text that can be cut from one part of 
the page and pasted to another. Or you can copy a range of 
text. 

To define the range, put the pointer at the first character and 
click. The cursor should flash there. Hold down the button 
and move the pointer to the end of the range. Release the 
button. The range should be highlighted. 

Click on the "Text" menu, select "Cut" and the range you 
defined will disappear. Then move the pointer to another 
window and click. Select "Paste" from the "Text" menu and 
the range will appear there. You can only store one range of 
text at a time in this text scrap file. 
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If you have already typed text you can change its style by 
defining the range and selecting a new style. Move the 
pointer to the first letter and click. Hold down the button and 
move to the end to highlight the range. Release the button. 

Click on the "Style" menu and choose the style you want for 
the range. If you define a block to change to bold, for 
example, and within that block there is text that had been 
changed to, say, italics, earlier, then the text will only turn 
bold up to the point where the italics starts. You may need 
to experiment to see the effects of style changes. 

In the sample, a photo has been added in the middle of the 
story to make the layout more interesting. Click on the 
"Photo" menu, select "Create" and draw a photo window in 
the middle of the text. Text reformats around the window. 

Then scan through the pictures in the album until you find the 
photo that goes here. Position it with the arrow keys and 

crop it if you wish using the "Change Size" feature. If you 
move it around the text will reformat again. 
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Another 
Window 

Preview 

Save 

The bottom window on the left contains the remaining text 
that appears on the "Photo Phinish" newsletter page. 

This is like the window above. First type in all the text. The 
smaller headline, "Advice, Words of Wisdom, etc.," should 
be in Roma 18 point. The larger headline, "Letters To Max," 
can be Roma 18 point bold. Then the body text should be the 
standard 9 point Roma. 

When text is typed in, open a Photo Window where you 
want the picture to go. Scan the album until you find the right 
one. Position it with the arrows at the top of the screen. 

That is the complete page. This is a good time to preview it 
again before printing it. Click on the "File" menu and select 
"Preview." A reduced version of the full page is shown. 

It's also a good time to save again. Click on "File" and 
select" Save." The current file name is shown. If that is OK, 
press the RETURN key. To change the name, backspace 
and type a new one. 
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Since you have phinished (sorry, couldn't resist) entering 
everything into this page of "Photo Phinish" you probably 
would like to print out a copy. 

Click on the "Print" menu and click OK if everything is ready 
to go. Be sure the printer is on and selected and the paper is 
loaded. Your newsletter page will be printed. 

That's the way it's done with Personal Newsletter. Just 
follow the commands on the menu and the rest is up to your 
own creativity. 
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Chapter 10: 
Hints and Tips 

How come some newsletters or other written 
communications look so good? It's purely design. Some 
people have a knack for making a newsletter or document 
look clean, slick and appealing. Many of those people are 
accomplished professionals with years of experience. Their 
job is to create a distinctive page. 

If you are not a professional or don't feel you know how to 
make a page look slick, then there are some things you can 
do to develop the skill. 
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The best sources of design ideas are all around you. Every 
day in the mail or in magazines and newspapers you see lots 
of slick looking ads, newsletters, designs and other pages 
that use text and graphics to communicate ideas. 

In fact there's so much information around that designers 
have to continually corne up with new ideas in order to get 
attention for their message. 

That's what you should do. Observe the works of the 
greatest designers in the world, clip out the layouts and 
graphic elements that appeal to you and use Personal 
Newsletter to help you create your own design. 

Keep a file of designs that you think are great. When it's 
time to design a new document, flip through the file for 
inspiration. It's easier than looking at a blank layout screen. 

When you are ready to create a design, first detemline 
"what's the message?" Your design should reflect an 
appropriate mood for the message. 
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If you write a monthly newsletter on a serious topic, you 
don't want cartoons and silly graphics. But if the topic is kind 
of light, silly graphics will get the message across just great. 

Everything in the layout -- the pictures, headlines, title, text 
style -- contributes to the tone of the page. They have to fit 
together logically and appropriately. 

Take a newspaper as an example. The information at the top 
of a page is usually more important than what's at the 
bottom. The first page of a newspaper reflects the news that 
the editors felt was most important to readers. And the right 
column reflects the most important news on the first page. 

It's the same with a newsletter. A giant headline isn't 
usually appropriate at the bottom of a page. Pictures should 
be next to the story they are about. Headlines should tell 
what the story is about. 

People have expectations about how information is 
presented, based on experience. If you go against what we 
are used too, you confuse us. (Sometimes going against the 
norm can enhance your ability to attract attention.) 
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With this message in mind, the next step is to plan the 
layout using windows. It doesn't have to be set in stone, but 
a rough set of windows can help you balance the information 
that needs to be there. Here are a few rules you can use. 

Balance the page. If you know there are three stories that 
have to make the front page, the layout will help you write to 
make them fit (or help you plan when to jump a story to 
another page). 

Keep the layout simple. Too many columns on a page will 
look too cluttered and it will be hard to read. 

Leave room for air. A page that is jammed with text, 
without pictures, headlines and white space is a page that 
will get ignored. 

Lead the reader through the page. The layout does that. 
Graphics and columns help to distinguish various 
information. Headlines provide guidance. 
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Write 
the Text 

Go Easy 
On Style 

Headlines 

With the layout set on screen, you should write the text in 
the columns that you set aside for stories. 

Newsletters generally don't have too much space. They are 
intended to provide concise information about a specific topic. 

So you can't be too wordy. Get right to the point. And you'll 
see that the page fills up fast. 

There's lots of text styles available: bold, italics, underline, 
reverse, and normal. Plus you can use any combinations of 
those styles. 

But it doesn't mean you have to use all the styles, all the 
time. For example, if you use boldface or underlining 
sparingly it will convey more meaning when you need it. 

Write the headlines to tell the story in a few words. 
Headlines should be understandable and tell a reader what 
the article is about without having to read it. 
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A headline should be a sentence, if somewhat short. 

"Board Picks Higgins 
As New Chief Executive" 

is a better headline than: 

"About Higgins" or 

"What's New From The Board of Directors" 

Write the story, then write the headline and see if it tells the 
story. 

Pictures are great. They can tell a lot in a little time. They 

can sharpen up a message. And they can draw people's 
interest in reading the story next to it. 

That's the reason for the excitement about desktop 
publishing compared to mere word processing. 
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Create 
Templates 

So make sure you leave extra room for some pictures. Use 
the appropriate ones that contribute to the stories. 

For most people, using clip art is a whole lot easier than 
drawing a picture from scratch. Very few people are skilled 
enough to draw a picture with a pencil, much less master the 
complexities of a computer and its clumsy input peripherals. 
Mice and joysticks are nice but they are never easier than 
pushing a pencil around a piece of paper. 

There's a lot of clip art available, either from Softsync or from 
companies that offer clip art disks for Print Shop Because 
Personal Newsletter reads files from Print Shop, you have 
thousands of images available to you. 

And geoPaint is perfect for touch up and customization of the 
graphics. 

A lot of a newsletter production can be used over and over. 
The title section, columns, borders and other elements might 
stay pretty much the same from month to month. 
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So if you can figure out the basics of a page, save it as a 
"generic" file. When you need to do another document like it, 

you can load it and rename it (using the "Name" option in the 
"File" section). 

Newsletters should reflect good taste. They represent your 
business or your views so they end up reflecting your 
credibility. That part is up to you. 
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Chapter 11: 
Definition By Commands 

Photo 

This chapter has a definition of each Personal Newsletter 
option. It covers each menu, starting from the left. To select 
a menu or option simply move the pointer over it and click. 

This option is used for managing the photos that can be 
integrated into a newsletter page. 

Create: This is for indicating the size and position of a 
Photo Window. Click on Create, move the pointer to the 
place on screen where you want the left corner of the picture 
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to appear. Click once and stretch the rectangle to the size 
you want the picture to be on the page. Click again to lock 
the window into position. 

The first picture in the Photo Album on the work disk will 
appear in the window. You can move through the pictures in 
the album by clicking on the plus and minus keys. 

Pictures can be moved within a window for better cropping by 
pressing the arrow keys that appear at the top of the screen 
when a picture appears. You can bring up the cropping 
arrows anytime by clicking on a picture. 

Remove: To remove a photo from the page, select the 
Remove option from the "Photo" menu and click on the 
picture to remove. The border will disappear. Without 

moving the pointer, click again and the window is removed. 

Move: A photo window can be moved anywhere on the 

page by selecting "Move" and clicking on the photo window 

you want to move. The outline will get thicker which means 
the window has been selected and you can move it with the 
pointer. Click again to lock its position. 
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Window 

Change Size: The size of a photo window can be changed 
by selecting "Change Size" and clicking on the window. The 
outline will get thicker which means the window has been 
selected and the pointer goes to the right bottom corner. 
You can stretch it larger or shrink it down with the pointer. 
Click again to lock its position. 

Cancel: If you are in the middle of an operation and want to 
stop, move the pointer to the Cancel option and click. 

This option is similar to the "Photo" menu option except it is 
used for creating windows that text can be typed into. 

Create: This is for indicating the size and position of a text 
Window. Click on Create, move the pointer to the place on 
screen where you want the left corner to appear. Click once 
and stretch the rectangle to the size you want to allocate for 
the text. Click again to lock it into position. 

When you type text it will word wrap when it reaches the 
end of the window. And if you edit or delete text, the block 

will reformat automatically. 
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Remove: To remove a text window from the page, select 
the Remove option from the "Window" menu and click on the 
one to remove. The border will disappear. Without moving 
the pointer, click again and the window is removed. 

Move: A window can be moved on a page by selecting 
"Move" and clicking on the- text window you want to move. 
Move it with the pointer and click again to lock its position. 

Change Size: The size of a text window can be changed by 
selecting "Change Size" and clicking on the window. The 
outline will get thicker which means the window has been 
selected and the pointer goes to the right bottom corner. 
You can stretch it larger or shrink it down with the pointer. 
Click again to lock its position. 

Cancel: If you are in the middle of an operation and want to 
stop, move the pointer to the Cancel option and click. 

This option will change the way text looks and how it 
appears on the page. It provides various styles that can be 
selected: Plain, Bold, Italics, Underline, Reverse and 
Centering. 
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Select the style or combination of styles you want and any 
subsequent text you type will be in that style until you 
change it. 

Or you can define an existing range of text and change its 
style by highlighting it and choosing a style. 

If you select Center, all text that you subsequently type will 
be centered within the column. Or you can define a range of 
existing text and select the Center option. The centering 
doesn't take effect until you press a carriage return. 

There are short cut keys for selecting styles, instead of 
clicking on the menu. Hold down the Commodore logo key 
(bottom left of the keyboard) and press the following: 

P Plain 
U Underline 
B Bold 
I Italic 
R Reverse 
C Center 
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There are a number of fonts available when using Personal 
Newsletter. Fonts are installed on the work disk from the 
GEOS system disk so whichever ones you installed will 
appear on the menu. 

The BSW 9 point and University 6 point fonts are part of the 
system and are always there. The BSW font uses the least 
amount of memory so it is recommended for use as the body 
copy on a page if your memory is running low. 

A font is selected by highlighting it. An asterisk indicates 
that it is selected. The selection doesn't take effect until you 
press RETURN. 

A second menu opens offering a selection of font sizes, 
expressed in points. Highlight the appropriate point size to 
select it. 

Text can be cut from one section and pasted to another, or 
copied in blocks. 
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Cut: Move the pointer to the first character in the text you 
want to cut and click. Hold down the button and move the 
pointer to the last character. The block of text will be 
highlighted. 

Then click on the "Text" menu and select "Cut." The 
highlighted block will disappear. 

Paste: Move the pointer to the place where you want to put 
the block of text you cut earlier and click. The text will 
appear there. If you intend to paste a block of text, be sure 
to do so right after you have cut it. When you cut, the text 
goes to a temporary buffer for pasting. If you do something 
else it will be erased from the buffer. 

Copy: This is like cutting text except the range will remain 
and a copy will appear elsewhere. 

Move the pointer to the first character and click. Hold the 
-button down and move to the last character, highlighting the 
range. 
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Then move to the place where you want the copy and click. 

Cancel: If you are in the middle of an operation and want to 
stop, move the pointer to the Cancel option and click. 

Select this option to print out the current page. A prompt will 
ask you to confirm you want to go ahead. Remember to turn 
your printer on and align the paper. 

If the page doesn't print, refer to the printing chapter and the 
appendix as well as the GEOS manual. As with any GEOS 
document, you have to have the correct printer driver on your 
work disk, and you have to have your printer and interface 
switches configured correctly. 

Load: This is to load a Personal Newsletter page. A 
dialogue box will display the newsletter files on the work 
disk. Highlight one and click on Open. 

If all the names won't fit in the window, click the down arrow 
to scan through the additional file names. 
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Be sure to save your current page before loading another 
one. 

Save: This is for saving a newsletter page. A dialogue box 
will request a file name which can be up to 16 characters. If 
the page has been saved already and you are updating it, the 
current file name will be displayed. Press RETURN to 
accept that and confirm that you want to replace the older file 
with the current one. 

If you want to create another file and keep the old one intact, 
backspace over the name and type a new one. 

Make sure there is enough room on the disk or you will get a 
Disk Full message. 

Preview: Select this option to see what a full page looks 
like. A reduced version is shown on screen. This is useful 
during the process of creating a page as well as before 
printing the final layout. 

New: This command will clear the current page if you 
respond OK to the prompt. Back out by pressing Cancel. 
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This clears the page from MEMORY, not the disk. 

Quit will ask you to confirm that you want to exit Personal 
Newsletter and go back to the desktop. Remember to save 
your page first. 
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Appendix A: 
Sample Newsletter 
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When you create a newsletter page you should observe the 
use of memory. Using the system fonts -- BSW, 9 point and 
University, 6 point -- don't use too much memory. Pictures, 
because they are stored in albums and called in as needed, 
don't use much space either. 

Extra fonts and font sizes use the bulk of the memory. This 
table shows the approximate use of fonts. As a rule of 
thumb, limit your mix of fonts. 

When a font is loaded into the program it will allocate a 
percent of space. Then each 100 characters takes up about 
1 % of additional space. These are estimates, so leave some 
room for error. 

BSW 9 point 
University 6 point 

University 10 point 
University 12 point 

0% 
0% 

9% 

11% 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I Personal Newsletter Appendices 

I University 14 point 14% 

I University 18 point 21% 
University 24 point 34% 
California 10 point 9% 

I California 12 point 12% 
California 14 point 14% 

I 
California 18 point 22% 
Rorna 9 point 8% 
Rorna 12 point 12% 

I Roma 18 point 22% 
Roma 24 point 36% 

I 
Cory 12 point 13% 
Cory 24 point 41% 
Dwinelle 18 point 26% 
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Fonts on Disk 

These are samples of the fonts that come with GEOS version 

1.3. 
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E!SW 9 Point 

Ronu 9 Point 

Ca.lirornia 12 Point 

r:[lr~ .:rl f[Jllll 

Univer5it.y 14 Point. 

Calif ornia 18 Point 
IJniversit.y 18 Point 

Rama 24 Point 
L()r~ ~LJ f()irJi 

LJniversity 24 Point 
iltut ntllt lS ~otnt. 
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Appendix D: 
Type Styles 

These are the various type styles that you can select and 
some combinations. 

Plain 
lJoder]ioe 
Bold 
If·~ .7,:·-c 

!l.C?'IIL·,_} 

ll/z(lerlJize & Itillj()-' 

/130';:S & Bold 
I~ -R.llln 
Bold. Itilbes" Unocrbnc ,. 
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These are some common printer settings and drivers used: 

Apple ImageWriter, II or Scribe 
Use RS-232 interface, use ImageWriter, II or Scribe driver 

Blue Chip M120/l0 
Set card to transparent or Epson, use Blue Chip driver. 

C.Itoh 8510, NEC 8023, 8023A 
Set interface to transparent or Prowriter, use C.Itoh driver. 

Commodore 1525, MPS-SOl, 
Use Commodore MPS-SOI driver 

Commodore MPS-S03, MPS-lOOO 
Use Commodore MPS-lOOO driver 

Commodore 1526, MPS-S02 
Use Commodore 1526 driver 
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Epson MX-80/100 
Set interface to transparent or Epson, use MX-80 driver. 

Epson FX-80/100, RX-80/100 
Set interface to transparent or Epson, use FX-80 driver. 

Epson IX-80 
Set interface to transparent or Epson, use IX-80 driver. 

Ergo Hush 80CD 
Use Commodore MPS-1000 driver 

Hewlett Packard Laserjet 
Use RS-232 interface,HP Laserjet driver 

Mannesmann Talley Spirit 
Set interface to transparent or Epson, use Blue Chip driver. 

Okidata Okimate 10, Okidata 120 
Use Okimate 10, Okimate 120 drivers 

Okidata Microline 92, 93 
Set interface to transparent or Oki, use ML92/93 driver. 
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Panasonic KX-P109l 
Set interface to transparent or Epson, use FX-80 driver. 

Seikosha SP-1000VC 
Use Commodore driver 

Star Gemini lOX 
Set interface to transparent or Epson, use Gemini lOX driver. 

Star Gemini II 
Use Commodore driver. 

Star Micronics NX-IO 
Set interface to transparent or Epson, use Star NX -10 driver. 

Star Micronics NX-lOC 
No interface card, use Star NX-lOC driver. 

Star SG-IO/15 
Set interface to transparent or Epson, use SG-lOIl5 driver. 

Star NB-15 

Set interface to transparent or Epson, use Star NB-15driver. 
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Star NL-lO with Commodore interface 
Set interface to transparent or Epson, use Star NL-109 
driver. 

Toshiba PA7253 
Set interface to transparent or Prowriter; C.Itoh 8510 driver. 

According to the GEOS manual some of the printer cards 
that work with GEOS are Cardco Card?+G, GWhiz, Super G; 
Micrographix MW350; Telesys TurboprintGT; Xetec Graphic 
Printer Interface; Super Graphix and Super Graphix Jr. 

You should defeat any auto line-feed settings on the printer 
and interface card. 

Note that the printer is addressed as device #4 on the serial 
bus. Set the printer or card to device #4. 

These drivers were created by Berkeley Softworks so you'll 
find additional information in the GEOS 1.3 manual. 
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the design, development, coding and debugging phases of the 
program. He also validated and tested the software. 

I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 

Personal Newsletter Appendices 

Jeff has managed the preparation of many Softsync products 
and has worked with publishers such as CBS and Tandy. 

Rod Campbell 
Product Manager 

Rod put together the package and materials that are included 
with Personal Newsletter. He selected the free clip art that 
is provided with the program as well as designing additional 
collections of art for a library of disks available from Softsync. 

Rudolph Daniel 
Senior Programmer 

Rudy worked with Raymond and the art department to 
develop methods for creating and transferring high quality 
clip art for Personal Newsletter. 

Rudy is Softsync's Senior Programmer and has worked on 
many of the company's releases. 
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178 

Hector Jacome 
Artist 

Hector created and edited the. clip art that is provided with 
Personal Newsletter. 

He is currently an art student in New York City. 

Ken Currier 
Design 

Ken provided the original design for Personal Newsletter and 
oversaw the production of the software and documentation. 
He is Softsync's founder. 

Softsync and Personal Newsletter are trademarks of 
Softsync, Inc.; GEOS, geoPaint and geoWrite are trademarks 
of Berkeley Softworks, Inc.; Print Shop is a trademark of 
Broderbund Software, Inc. 
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Appendix G: 
Customer Service 

Service and 
Replacement 
Policy 

Copyright 

If this disk should fail within 90 days of purchase, return with 
proof of purchase for FREE replacement. After 90 days from 
date of purchase, include $7.50 for replacement, plus $2.00 for 
shipping and handling. 

Returning the defective copy, with proof of purchase to 
Softsync, Inc., 162 Madison Avenue, New York, N.Y. 10016. 
Attn: Customer Service. 

The manual and software described in it are copyrighted with 
all rights reserved. The manual or software may not be 
copied, in whole or part, without written consent of Softsync. 
You may not sell, rent, lease nor transfer copies of manual or 
software in any other way without prior written consent of 
Softsync. 
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SOFTSYNC LICENSE AGREEMENT 
Carefully read all the terms and conditions of this agreement prior to 
breaking the disk seal label. Breaking the disk seal indicates your 
acceptance of these terms and conditions. 

If you do not agree to these terms and conditions, return the unopened 
disk with the disk seal label intact and unbroken together with the other 
components of this product to the place of purchase and your money 
will be refunded. No refunds will be given if the product is returned 
with its disk seal label broken or removed, or if there are missing 
components. 

1. LICENSE: You have the non-exclusive right to use the enclosed 
software. This software can only be used on a single computer. You 
may not physically transfer the software from one computer to another 
over a network. You may not distribute copies of the software or docu­
mentation to others. You may not modify or translate the software or 
documentation without prior written consent of Softsync. You may not 
use, copy, modify, or transfer the software or documentation, or any 
copy, except as expressly provided in this agreement. 

2. LIMITED WARRANTY: The software and manual are sold "AS 
IS", without warranty as to their performance. The entire risk as to the 
quality and performance of the software is assumed by you. Softsync 
does not warrant, guarantee, or make any representations regarding the 
use of, or the results of the use of, the software in terms of correctness, 
accuracy, reliability, currentness, or otherwise, and you rely on the 
software and results solely at your own risk. You, and not Softsync or 
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any dealer or distributor, assume the entire cost of necessary servicing, 
repair, or correction and any incidental or consequential damages. 

Softsync warrants to the original purchaser that the medium on which 
the software is recorded shall be free from defects in materials and 
workmanship under normal use and service for a period of ninety (90) 
days from the date of purchase. If during this period a defect in the 
product should occur, the product may be returned to Softsync postage 
pre-paid with proof of purchase. 

Softsync will replace or repair the product at Softsync's option without 
charge to you. Your sole and exclusive remedy in the event of a defect 
is expressly limited to replacement or repair of the product as provided 
above. If failure of the product resulted from accident, abuse or misap­
plication, then Softsync shall have no responsibility to replace or repair 
the product under the above terms. 

The above warranties for goods are in lieu of all other express war­
ranties and no implied warranties of merchantability and fitness for a 
particular purpose or any other warranty obligation on the part of 
Softsync shall last longer than ninety (90) days. Some states do not 
allow limitations on how long an implied warranty lasts, so the above 
limitation may not apply to you. In no event shall Softsync be liable 
for indirect, special, or consequential damages, such as, but not limited 
to, loss of anticipated profits or benefits resulting from the use of this 
software, or arising out of any breach of this warranty. Some states do 
not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitation may not apply to you. This warranty 
gives you specific legal rights, and you may also have other rights which 
vary from state to state. 

3. TERM: This license is effective until terminated. You may 
terminate it by destroying the software and documentation and all 
copies thereof. This license will also terminate if you fail to comply 
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with any term or condition of this agreement. You agree, upon such 
termination, to destroy all copies of the program and documentation. 

4. MISC: This license agreement shall be governed by the laws of the 
State of New York and shall inure to the benefit of Softsync, Inc., its 
successors, administrators, heirs, and assigns. 

5. ACKNOWLEDGEMENT: You acknowledge that you have read this 
agreement, understand it, and agree to be bound by its terms and cond­
itions. You also agree that this agreement is the complete and exclusive 
statement of agreement b"etween the parties and supersedes all proposals 
or prior agreements, verbal or written, and any other communications 
between the parties relating to the subject matter of this agreement. 

SOFTSYNC, INC. MAKES NO WARRANTIES, EITHER EXPRESS 
OR IMPLIED REGARDING THE GEOS SOFTWARE PACKAGE, ITS 
MERCHANT ABILITY OR FITNESS FOR ANY PARTICULAR 
PURPOSE. GEOS IS THE PROPERTY OF BERKELEY SOFTWORKS 
AND IS IN NO WAY ASSOCIATED WITH SOFTSYNC. 
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I A 
Adding drives, 111 

I 
Arrows, 90 
Art prep, 128 
Available memory, 31 

I B 

I 
Backspace, 69 
Back up data, 26 

Bold, 38, 72, 133, 158 

I Brush,91 
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C 
Carriage return, 74, 159 
Center, 39, 74, 158 
Change size, 48, 55,62,77, 157, 158 
Circles, 91 
Clear page, 81, 124, 163 
Clip art, 41,83, 117, 153 
Columns, 53 

Commodore key, 18, 73, 74, 159 
Convert utility, 120 
Copy, 39,44, 72, 111, 112, 113, 115, 130, 143, 161 
Cut, 39, 44, 70, 143, 161 

D 
Daisy wheel printer, 16 
Data disks, 27 
Delete, 48, 56, 63, 69, 156, 158 
Design, 36 

Destination disk, 111 
Device number, 19, 175 

Digitized pictures, 41, 83, 117 

DIP Switches,l05, 106 
Disk drives, 19, 111 
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Dot matrix, 16 
Drawing tools,89 
Drivers, 21, 24, 102, 110, 172-175 
Duplicate, 112 

E 

Edit graphics, 95, 96, 130 
Erase, 95, 130 

F 
File, 33,48,49, 54, 60, 64, 68, 79, 103, 109-125, 145, 162 
Fill,94 
Fonts, 21, 34, 37,74,93,133, 140,160,168, 170 
Format disks, 23, 112 

G 
GeoPaint, 22, 41,42, 83, 87-97, 101, 128 
GEOS system, 16,21,29, 75, 79, 101, 104, 117, 125 
Ghost icon,113 
Graphics, 41, 56, 83-100 

H 
Hints, 147-154 
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I 
Icons, 20, 30, 110 
Import, 46, 60, 100, 117 
Info, 113 
Input device, 18 
Insert, 69 
Italics,38, 72, 158 

J 
Joystick, 16, 18,31,53,69 

L 
Layout, 51-66, 134, 150 
Line, 90 
Line feed, 175 
Loading, 16,29,32,60,68,112,121,162 

M 
Main menu, 30 
Measure, 94 
Memory required, 31, 132, 168 
Mouse, 16, 18,31,53,69 
Move, 48, 56, 63,156,158 
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N 

I New page, 81, 124, 163 

I 
p 

Paste, 39, 44, 71, 115, 131, 143, 161 
Patterns, 95 

I Pencil, 90 
Photo album, 41, 43, 56, 84, 97, 115 

I 
Photo manager, 23, 45,57,58,97, 131 
Photo scrap,41, 56 
Pixels,96, 107 

I Point size, 37, 38, 76, 168 
Preview, 48, 54, 78, 102, 138, 145, 163 

I 
Printer interface, 104, 172-175 
Printers, 16,21, 172-175 
Printing, 50, 55, 78, 101-108, 146, 162 

I Print Shop, 41, 83,120 

Q 

I Quick tour, 29-50 
Quit, 50, 108, 164 
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R 

Range, 39 
Rectangle, 92 
Remove, 48, 56, 63, 156, 158 
Rename, 111, 112 
Reverse, 38, 72, 133, 158 
Rulers, 31, 53 

S 
Sample, 127-146, 167 
Saving, 49, 63, 79, 120, 122, 145, 163 
Scrapper utility, 120 
Spray, 94 
Style, 37, 72, 93, 133, 144, 151, 158, 171 
System requirements, 15 

T 
Templates, 64, 122, 140, 153 

Text, 32, 36, 67-81,92,137,140,144,160 
Tips, 147-154 
Trouble shooting, 104 
Type, 37 
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U 
Underline, 38, 72, 133, 158 

Undo, 96 

W 
VVindows, 34, 35, 46, 52, 60, 77, 78, 85, 132, 136, 144, 155, 157 

VV ord wrap, 69 
VV ork disk, 21, 84, 114, 130 

VVrap text around photos, 78, 87 

VVrite protect, 113 
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